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1.  Wst � p
JTAG-lock-pick Tiny 2  to  JTAG do procesorów z rdzeniem ARM pod
� czany do komputera  PC 
przez magistral�  USB 2.0. Urz� dzenie oparte jest o uk
ad FTDI FT232H1, czyli jednokana
owy kon-
werter USB <=> UART/FIFO. Projekt JTAG-lock-pick Tiny 2  powsta
 z my� l�  stworzenia ma
e-
go i taniego, ale jednocze� nie w pe
ni funkcjonalnego i szybkiego interfejsu o szerokim zastosowa-
niu.

Rys. 1: JTAG-lock-pick Tiny 2 - pcb

Dzi� ki wykorzystaniu magistrali USB urz� dzenie mo� na pod
� czy�  do praktycznie ka� dego istniej� -
cego komputera PC, co nie jest mo� liwe przy wykorzystaniu interfejsu równoleg
ego (LPT), który 
odchodzi ju�  w ca
kowite zapomnienie. Dzi� ki wykorzystaniu nowszego standardu –  USB 2.0 – 
szybko��  pracy wzrasta o 30 – 270% w porównaniu do USB 1.x2.

Interfejs JTAG pozwala na osi� gni� cie cz� stotliwo� ci zegara do 30MHz oraz na wykorzystanie try-
bu RTCK (tzw. Adaptive Clocking, w którym dzi� ki sprz�� eniu zwrotnemu pr� dko��  zegara dopaso-
wuje si�  dynamicznie do pr� dko� ci  uk
adu docelowego). Dzi� ki  zastosowaniu zaawansowanego 
uk
adu CPLD firmy Lattice z serii ispMACH 4000ZE3 w roli uk
adu buforuj� cego mo� liwa jest ko-
munikacja z uk
adami zasilanymi napi� ciami z szerokiego zakresu – od 1,4V do 3,6V. Wej� cia inter-
fejsu s�  odporne na sygna
y o napi� ciu wy� szym ni�  napi� cie zasilania (do 5,5V), wi� c mo� liwa jest 
równie�  praca z uk
adami zasilanymi napi� ciem  5V przy spe
nieniu dodatkowych za
o� e�  (patrz 
rozdzia
 2.3).

1 http://www.ftdichip.com/Products/ICs/FT232H.htm  
2 http://permalink.gmane.org/gmane.comp.debugging.openocd.devel/21828  
3 http://www.latticesemi.com/products/cpld/ispmach4000ze/index.cfm  
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Dodatkowo JTAG-lock-pick Tiny 2  wspiera komunikacj�  z uk
adem docelowym przez nowszy in-
terfejs SWD (Serial Wire Debug), w którym do komunikacji wystarczaj�  tylko dwie linie – dwukie-
runkowa linia danych SWDIO oraz zegar SWCLK.

Interfejs  JTAG-lock-pick Tiny 2  mo� na równie�  wykorzysta�  do programowania innych typów 
uk
adów, takich jak FPGA, CPLD, AVR czy MIPS.

JTAG-lock-pick  Tiny 2  jest  cz�� ciowo kompatybilny z interfejsem  KT-LINK4 firmy  KrisTech, 
dzi� ki czemu w wielu aplikacjach mo� na korzysta�  z gotowych ustawie�  konfiguracyjnych zamiast 
tworzy�  je r� cznie.

Interfejs JTAG-lock-pick Tiny 2  posiada rozdzielone linie SRST i TRST, które mo� na dodatkowo 
niezale� nie konfigurowa�  na prac�  w trybie push-pull lub open-drain.

Projekt  JTAG-lock-pick Tiny 2  jest zminiaturyzowan�  i unowocze� nion�  wersj�  projektu  JTA-
G-lock-pick 1.x.x5.

Rys. 2: JTAG-lock-pick Tiny 2

Na rysunku 1 przedstawiona jest zmontowana p
ytka uk
adu JTAG-lock-pick Tiny 2 , natomiast na 
rysunkach 2 i 3 przedstawiony jest uk
ad w pe
ni� cej rol�  obudowy przezroczystej koszulce termo-
kurczliwej.

1.1.  Obs
ugiwane uk
ady
Interfejs  JTAG-lock-pick  i obs
uguj� ce go oprogramowanie na komputer  PC (m.in.  OpenOCD, 
Atollic TrueSTUDIO, CooCox CoIDE, Keil MDK-ARM, IAR Embedded Workbench for ARM, Row-

4 http://www.shop.kristech.eu/product_info.php?products_id=257  
5 http://www.distortec.pl/jtag-lock-pick  
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ley CrossWorks for ARM, patrz rozdzia
 4) s�  w stanie komunikowa�  si�  z praktycznie ka� dym ist-
niej� cym typem procesora ARM, w tym z najpopularniejszymi:

� Cortex-M3 (STM32, LM3S, LPC17xx, AT91SAM3, …),
� ARM7 (LPC2xxx, AT91SAM7, STR7xx, ...),
� ARM9 (LPC3xxx, AT91SAM9, STR9xx, ...),
� ...

Dodatkowo interfejs  mo� na wykorzysta�  do programowania innych typów uk
adów,  takich jak 
FPGA, CPLD, AVR czy MIPS.

Jedynym czynnikiem limituj� cym jest obs
uga danego uk
adu przez oprogramowanie na kompute-
rze PC.

Rys. 3: JTAG-lock-pick Tiny 2

1.2.  „Mocne strony” projektu JTAG-lock-pick Tiny 2
� magistrala USB 2.0 Hi-Speed 480Mbps,
� wsparcie dla interfejsu SWD (Serial Wire Debug),
� cz� stotliwo��  zegara JTAG do 30MHz, mo� liwo��  pracy w trybie Adaptive Clocking z wy-

korzystaniem linii RTCK,
� bezpieczna i bezproblemowa wspó
praca z uk
adami docelowymi zasilanymi napi� ciem z 

zakresu od 1,4V do 3,6V, mo� liwo��  wspó
pracy z sygna
ami o poziomie do 5,5V, wszystkie 
sygna
y buforowane przez zaawansowany uk
ad CPLD,

� rozdzielone linie SRST i TRST, które mo� na dodatkowo niezale� nie konfigurowa�  na prac�  
w trybie push-pull lub open-drain,
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� ca
o��  zamkni� ta w „obudowie” z przezroczystej koszulki termokurczliwej, dzi� ki czemu 
JTAG oraz pod
� czony do niego komputer i uk
ad docelowy s�  zabezpieczone przed przy-
padkowym uszkodzeniem,

� niewielki rozmiar ca
o� ci (wymiary oko
o 55mm x 34mm x 12mm) i niewielka cena komple-
tu,

� ...

1.3.  Zawarto ��  zestawu
� debugger / programator JTAG-lock-pick Tiny 2 , lutowany maszynowo, przetestowany, za-

mkni� ty w „obudowie” z przezroczystej koszulki termokurczliwej (wymiary oko
o 55mm x 
34mm x 12mm) (rysunek  1, 2 i 3),

� ta�ma przy
� czeniowa JTAG <=> target, 20cm, (rysunek 4),
� kabel USB mini-B, czarny, 1,8m,
� p
yta  DVD z instrukcj� , sterownikami, kompletem przydatnych programów – darmowych 

(toolchainy  gcc:  CodeSourcery,  Linaro oraz  bleeding-edge-toolchain;  IDE Eclipse,  Ope-
nOCD,  CooCox CoIDE) i komercyjnych w wersjach testowych (Atollic TrueSTUDIO for  
STM32 Lite,  Keil  MDK-ARM +  CooCox CoMDKPlugin,  IAR Embedded Workbench for  
ARM + CooCox CoIARPlugin,  Rowley CrossWorks for ARM) – wszystkie w najnowszych 
wersjach – oraz niezb� dnymi plikami.
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2.  Hardware

2.1.  Z
� cze JTAG
Rozk
ad sygna
ów w gnie� dzie JTAG (przedstawiony w tabeli 1) jest zgodny z tzw. „standardem”.

Tabela 1: Pinologia gniazda JTAG

JVCC – 1 2 – JVCC

nTRST – 3 4 – GND

TDI – 5 6 – GND

TMS / SWDIO – 7 8 – GND

TCK / SWCLK – 9 10 – GND

RTCK – 11 12 – GND

TDO – 13 14 – GND

nSRST – 15 16 – GND

n/c – 17 18 – GND

n/c – 19 20 – GND

Linie  JVCC s�  liniami zasilaj� cymi cz���  uk
adu buforuj� cego (CPLD). Na rysunku 4 pokazana 
zosta
a typowa 20-to � y
owa ta�ma po
� czeniowa.

2.2.  Diody LED
Na p
ytce JTAG-lock-pick Tiny 2  znajduj�  si�  cztery diody sygnalizacyjne LED. Ich znaczenie jest 
nast� puj� ce:

� D_USB (zielona), przy gnie� dzie USB – zako� czenie enumeracji urz� dzenia USB, poprawne 
wykrycie JTAG-lock-pick Tiny 2  przez komputer PC,

� D_JVCC (zielona), przy gnie� dzie  JTAG – obecno��  prawid
owego napi� cia zasilaj� cego 
cz���  uk
adu buforuj� cego (CPLD) interfejsu JTAG (i uk
ad docelowy),

� D_SRST (� ó
ta), przy gnie� dzie JTAG na � rodku p
ytki – linia nSRST jest w stanie aktyw-
nym (niskim) – uk
ad docelowy jest zresetowany,

� D_LED (czerwona), przy gnie� dzie  JTAG na � rodku p
ytki – stan tej diody kontrolowany 
jest przez aplikacj�  komunikuj� c�  si�  z interfejsem, np. w przypadku OpenOCD dioda miga 
gdy interfejs jest poprawnie po
� czony z oprogramowaniem na komputerze PC.

2.3.  Wspó
praca z uk
adami zasilanymi napi � ciem 5V
Interfejs JTAG-lock-pick Tiny 2  standardowo pozwala na wspó
prac�  z uk
adami docelowymi za-
silanymi napi� ciem od 1,4V do 3,6V, jednak przy spe
nieniu dodatkowych za
o� e�  i odpowiedniej 
„konfiguracji”  sprz� towej mo� liwa jest wspó
praca z sygna
ami o poziomie do 5,5V, a wi� c z uk
a-
dami docelowymi zasilanymi napi� ciem 5V.

Za
o� enia te s�  nast� puj� ce:
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1. do pinów 1 i 2 gniazda JTAG (JVCC) nale� y doprowadzi�  napi� cie z zakresu 1,4V do 3,6V 
(np.  3,3V),  do tych linii absolutnie nie wolno do
� cza�  napi� cia wy� szego ni�  3,6V (a 
wi� c np. napi� cia zasilaj� cego uk
ad docelowy równego 5V),

2. uk
ad docelowy musi poprawnie interpretowa�  sygna
y o napi� ciu (JVCC – 0,4V) jako stan 
wysoki – przyk
adowo dla JVCC równego 3,3V napi� cie na wyj� ciach interfejsu dla stanu 
wysokiego mo� e wynosi�  od 2,9V do 3,3V, nie jest wi� c mo� liwa wspó
praca z uk
adami za-
silanymi napi� ciem  5V okre� laj� cymi minimalny poziom stanu wysokiego na  0,7 * VCC 
(3,5V) – informacje tak�  mo� na znale��  w nocie katalogowej danego uk
adu,

3. w zale� no� ci od konfiguracji sprz� towej docelowego urz� dzenia u� ycie trybu push-pull dla 
linii nSRST i/lub nTRST mo� e nie by�  mo� liwe, nale� y wi� c stosowa�  tryb open-drain z do-
datkowymi rezystorami podci� gaj� cymi do napi� cia zasilania uk
adu docelowego.

Prawid
owe dzia
anie uk
adu w takiej sytuacji mo� liwe jest tylko przy spe
nieniu wszystkich po-
wy� szych za
o� e� .

Rys. 4: Standardowa ta� ma po
� czeniowa JTAG
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3.  Sterowniki
Pierwsze pod
� czenie JTAGa do komputera zaowocuje znalezieniem nowego urz� dzenia USB, dla 
którego nale� y zainstalowa�  wybrany sterownik. Zasadniczo dost� pne s�  trzy opcje:

� sterowniki WinUSB,
� sterowniki libusb-win32,
� sterowniki producenta uk
adu FT232H oparte o bibliotek�  ftd2xx.

Wybór uzale� niony jest  od oprogramowa-
nia, które b� dzie u� ywane do  debuggowa-
nia przy u� yciu  JTAG-lock-pick  Tiny 2 . 
Obecnie dost� pne w internecie wersje Ope-
nOCD korzystaj�  z  biblioteki  libusb-1.0 
(pliki konfiguracyjne w folderze scripts/in-
terface/ftdi/) lub libftdi, (pliki konfiguracyj-
ne w folderze scripts/interface/) a wi� c wy-
magaj�  sterowników  (odpowiednio)  Wi-
nUSB lub libusb-win32 - zalecany jest wy-
bór  pierwszej  opcji  (WinUSB),  gdy�  daje 
ona wymierny wzrost pr� dko� ci dzia
ania. 
Mo� liwa (cho�  skomplikowana)  jest  rów-
nie�  samodzielna  kompilacja  OpenOCD 
tak aby wykorzystywa
o ono nieco szybsze 
(w  systemie  Windows)  sterowniki  ftd2xx. 
	 rodowisko  CooCox CoIDE oraz wtyczki 
CooCox  CoMDKPlugin (dla  Keil  MDK-
ARM)  i  CooCox  CoIARPlugin (dla  IAR 
Embedded Workbench for ARM) korzystaj�  
ze sterowników ftd2xx. 	 rodowisko Rowley 
CrossWorks  for  ARM potrafi  wykorzysta�  
zarówno  sterowniki  ftd2xx jak  i  libusb-
win326.

Archiwum  zawieraj� ce  wszystkie  wersje 
sterowników dla  JTAG-lock-pick  Tiny 2 
znajduje si�  na do
� czonej do zestawu p
y-
cie  DVD w katalogu  Drivers.  Najnowsze 
wersje sterowników mo� na znale��  te�  na 
stronie  firmy  DISTORTEC 
(www.distortec.com)  w  dziale  Download 
oraz  na  stronie  Freddiego  Chopina 
(www.freddiechopin.info) w dziale  Down-
load �  Projekty �  JTAG-lock-pick.

W ka� dym przypadku zalecana jest instalacja wybranego sterownika w trybie ca
kowicie manual-
nym, w którym plik sterownika jest wskazywany wprost, a nie wyszukiwany przez system opera-
cyjny – w trakcie instalacji  jest to opcja  „Nie wyszukuj, wybior�  sterownik do zainstalowania” 
(patrz rysunek 5) w przypadku systemu Windows XP lub „Pozwól mi wybra�  z listy sterowników 

6 W chwili tworzenia tego dokumentu u� ywanie sterowników libusb-win32 z interfejsem JTAG-lock-pick Tiny 2  w 
� rodowisku CrossWorks (wersja 2.2.0) nie jest mo� liwe.

Rys. 5: R� czna instalacja sterowników w Windows XP

Rys. 6: R� czna instalacja sterowników w nowszych 
wersjach systemu Windows
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4.  Software
W� ród programów w których mo� na korzysta�  z JTAG-lock-pick Tiny 2  znajduj�  si�  najpopular-
niejsze narz� dzia dla procesorów z rdzeniem ARM, m.in.: OpenOCD, Atollic TrueSTUDIO, CooCox 
CoIDE, Keil MDK-ARM, IAR Embedded Workbench for ARM oraz Rowley CrossWorks for ARM. 
Korzystanie z JTAG-lock-pick Tiny 2  w tych programach zosta
o szczegó
owo opisane w kolej-
nych podrozdzia
ach.

Ze strony oprogramowania JTAG-lock-pick Tiny 2  mo� e by�  u� ywany jako KrisTech KT-LINK ze 
zmienionym numerem PID urz� dzenia USB – 0x8220. Dzi� ki temu u� ytkowanie uk
adu jest bardzo 
proste  – w wi� kszo�ci  przypadków wykorzystywane oprogramowanie  b� dzie  posiada
o gotowe 
konfiguracje dla tego JTAGa.

4.1.  OpenOCD 7

Interfejs  JTAG-lock-pick Tiny 2  jest obs
ugiwany przez  OpenOCD w wersji  0.6.1 i  nowsze – 
wspó
praca z wcze� niejszymi wersjami nie jest mo� liwa. Dalsze przyk
ady b� d�  oparte o w
a� nie t�  
wersj� ,  dla uproszczenia przyk
adów zamiast  pe
nej  nazwy pliku wykonywalnego (np.  openoc-
d-x64-0.6.1.exe) u� ywana jest nazwa skrócona openocd.

Dla JTAG-lock-pick Tiny 2  dost� pne s�  gotowe pliki konfiguracyjne:

� scripts/interface/ftdi/jtag-lock-pick_tiny_2.cfg – korzystaj� cy z biblioteki  libusb-1.0 i  ste-
rownika WinUSB,

� scripts/interface/jtag-lock-pick_tiny_2.cfg –  korzystaj� cy  z  biblioteki  libftdi i  sterownika 
libusb-win32.

Aby uruchomi�  OpenOCD z JTAG-lock-pick Tiny 2  mo� na skorzysta�  z nast� puj� cej komendy

openocd -f interface/ftdi/jtag-lock-pick_tiny_2.cfg  -f target/XXX.cfg
lub
openocd -f interface/ftdi/jtag-lock-pick_tiny_2.cfg  -f board/XXX.cfg
lub
openocd -f interface/jtag-lock-pick_tiny_2.cfg -f t arget/XXX.cfg
lub
openocd -f interface/jtag-lock-pick_tiny_2.cfg -f b oard/XXX.cfg

(w zale� no� ci od tego jakie zosta
y zainstalowane sterowniki i tego gdzie zlokalizowany jest plik 
konfiguracyjny dla docelowego urz� dzenia / uk
adu).

Dla przyk
adu – wywo
anie OpenOCD dla uk
adu z rodziny STM32F1x (ARM Cortex-M3) przy za-
instalowanych sterownikach WinUSB:

openocd -f interface/ftdi/jtag-lock-pick_tiny_2.cfg  -f target/stm32f1x.cfg

Je� li nie ma ku temu przeciwwskaza�  (takich jak np. brak fizycznego pod
� czenia na p
ytce, brak 
wsparcia w danym typie uk
adu, …), to zawsze warto skonfigurowa�  te�  u� ywanie dwóch oddziel-
nych linii resetu. Dodatkowo zawsze nale� y skonfigurowa�  pr� dko��  JTAGa:

openocd -f … -f … -c "adapter_khz XXX; reset_config  trst_and_srst;"

gdzie XXX to cz� stotliwo��  pracy JTAGa w kHz – powinna by�  przynajmniej 6x, a zwykle przynaj-
mniej 8x mniejsza ni�  cz� stotliwo��  rdzenia po resecie – przyk
adowo dla STM32F1x, które po re-
secie pracuj�  z cz� stotliwo� ci�  8MHz, nale� y u� y�  warto� ci 1000 (1MHz).

7 http://openocd.sourceforge.net/  
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Przedstawione powy� ej przyk
adowe wywo
anie powinno da�  efekt zbli� ony do poni� szego (komu-
nikaty zale� ne b� d�  oczywi� cie od wersji OpenOCD i u� ywanego uk
adu docelowego):

> openocd-x64-0.6.1.exe -f interface/ftdi/jtag-lock -pick_tiny_2.cfg -f 
target/stm32f1x.cfg -c "adapter_khz 1000; reset_con fig trst_and_srst;"
Open On-Chip Debugger 0.6.1 (2012-10-07-10:39)
Licensed under GNU GPL v2
For bug reports, read
        http://openocd.sourceforge.net/doc/doxygen/ bugs.html
Info : only one transport option; autoselect 'jtag'
adapter speed: 1000 kHz
adapter_nsrst_delay: 100
jtag_ntrst_delay: 100
cortex_m3 reset_config sysresetreq
adapter speed: 1000 kHz
trst_and_srst separate srst_gates_jtag trst_push_pu ll srst_open_drain
Info : clock speed 1000 kHz
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
Info : stm32f1x.cpu: hardware has 6 breakpoints, 4 watchpoints

OpenOCD mo� na równie�  wykorzystywa�  jedynie do programowania uk
adu docelowego z linii 
polece�  (lub przy u� yciu plików wsadowych / skryptów) przy u� yciu komendy:

openocd -f ... -f ... -c "adapter_khz XXX; reset_co nfig trst_and_srst; 
init; reset init; flash write_image erase YYY.EXT; reset run; shutdown;"

gdzie YYY.EXT to nazwa pliku wraz z rozszerzeniem, automatycznie obs
ugiwane rozszerzenia to 
„elf” , „hex”  i „bin” .

Komenda ta 
� czy w sobie kilka polece�  OpenOCD:

� init – wymagane jest przed kolejnymi komendami „wykonywalnymi” (innymi ni�  konfigu-
racyjne) w linii polece� ,

� reset init – resetuje, zatrzymuje uk
ad i przeprowadza opcjonaln�  inicializacj�  – zatrzymanie 
uk
adu jest konieczne przed jego programowaniem,

� flash write_image erase YYY.EXT – 
aduje do uk
adu zawarto��  z pliku YYY.EXT (gdzie EXT 
to rozszerzenie hex, bin lub elf), uprzednio kasuj� c pami��  (jedynie strony które zostan�  za-
pisane),

� reset run – resetuje i uruchamia uk
ad, dzi� ki czemu startuje wgrany program,
� shutdown – zamyka sesj�  OpenOCD.

Przyk
ad programowania uk
adu  z rodziny STM32F1x plikiem stm32_blink_led.hex przedstawiony 
jest poni� ej.

> openocd-x64-0.6.1.exe -f interface/ftdi/jtag-lock -pick_tiny_2.cfg -f 
target/stm32f1x.cfg -c "adapter_khz 1000; reset_con fig trst_and_srst; 
init; reset init; flash write_image erase d:/stm32_ blink_led.hex; reset 
run; shutdown;"
Open On-Chip Debugger 0.6.1 (2012-10-07-10:39)
Licensed under GNU GPL v2
For bug reports, read
        http://openocd.sourceforge.net/doc/doxygen/ bugs.html
Info : only one transport option; autoselect 'jtag'
adapter speed: 1000 kHz
adapter_nsrst_delay: 100
jtag_ntrst_delay: 100
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cortex_m3 reset_config sysresetreq
adapter speed: 1000 kHz
trst_and_srst separate srst_gates_jtag trst_push_pu ll srst_open_drain
Info : clock speed 1000 kHz
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
Info : stm32f1x.cpu: hardware has 6 breakpoints, 4 watchpoints
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
target state: halted
target halted due to debug-request, current mode: T hread
xPSR: 0x01000000 pc: 0x08000130 msp: 0x20000600
auto erase enabled
Info : device id = 0x20036410
Info : flash size = 128kbytes
wrote 22528 bytes from file d:/stm32_blink_led.hex in 1.382812s (15.910 
KiB/s)
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
shutdown command invoked

4.2.  Atollic TrueSTUDIO 8

W � rodowisku tym mo� na korzysta�  z JTAG-lock-pick Tiny 2  za po� rednictwem OpenOCD (patrz 
rozdzia
 4.1), cho�  wspó
praca nie jest bezproblemowa. 

Przed przyst� pieniem do konfiguracj�  nale� y skompilowa�  projekt i upewni�  si� , � e stworzony zo-
sta
 plik wynikowy z rozszerzeniem  .elf. W tle nale� y uruchomi�  OpenOCD –  „zewn� trznie” (z 
wiersza polece�  systemu operacyjnego) lub konfiguruj� c je w menu Run > External Tools > Exter-
nal Tools Configurations..., korzystaj� c z opisu w rozdziale dotycz� cym OpenOCD (patrz rozdzia
 
4.1).

Konfiguracj�  debuggowania mo� na  przeprowadzi�  za  pomoc�  opcji  Debug Configurations... z 
menu Run. W nowo otwartym oknie nale� y stworzy�  now�  konfiguracj�  typu  Embedded C/C++ 
Application i skonfigurowa�  w odpowiedniej kolejno� ci nast� puj� ce opcje:

1. w zak
adce Main w pole Project nale� y wpisa�  (lub wybra�  przyciskiem Browse...) projekt 
którego dotyczy�  b� dzie dana konfiguracja, a nast� pnie w znajduj� ce si�  wy� ej pole C/C++ 
Application nale� y wpisa�  (lub wybra�  przyciskiem Search Project... lub Browse...) plik wy-
nikowy projektu z rozszerzeniem .elf; w wi� kszo� ci przypadków pola te zostan�  ustawione 
automatycznie przy tworzeniu konfiguracji;

2. w zak
adce Debugger nale� y wybra�  opcj�  Connect to remote GDB server, a w pole Port  
number wpisa�  warto��  3333, pozosta
e opcje s�  ignorowane – ich warto��  nie ma znaczenia 
i nie nale� y si�  nimi sugerowa� ;

3. w zak
adce  Startup Debug nale� y usun��  ca
�  zawarto��  pola  Initialization Commands i 
wpisa�  tam:

# send "reset init" to OpenOCD
monitor reset init

8 http://www.atollic.com/index.php/truestudio   
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# load application to target via GDB
load
# send "reset init" to OpenOCD
monitor reset init
# set temporary breakpoint at main() and resume tar get
tbreak main
continue

4. nale� y zatwierdzi�  wszystkie zmiany przyciskiem Apply i mo� na od razu rozpocz��  sesj�  
debuggowania klikaj� c przycisk Debug.

Problemy we wspó
pracy pakietu  Atollic TrueSTUDIO w wersji  Lite z programem  OpenOCD to 
m.in.:

� brak mo� liwo� ci  „zresetowania” uk
adu docelowego podczas sesji  debuggowania przyci-
skiem Restart;

� komunikat  systemu operacyjnego o nieprawid
owym zamkni� ciu aplikacji  GDB podczas 
ko� czenia sesji debuggowania;

4.3.  CooCox CoIDE 9

W � rodowisku tym nale� y skorzysta�  z gotowej konfiguracji dla KrisTech KT-LINK. Wszelkie opcje 
konfiguracyjne dotycz� ce interfejsu JTAG odnale��  mo� na w menu Debug > Debug Configuration, 
po klikni� ciu na dost� pn�  tam konfiguracj�  dla danego projektu (zwykle b� dzie to nazwa_projektu-
.configuration). Ze znajduj� cej si�  na pierwszej zak
adce (Debugger) w groupboxie Hardware listy 
wyboru Adapter nale� y wybra�  pozycj�  KT-Link i po klikni� ciu przycisku Apply, nacisn��  przycisk 
Close.

4.4.  IAR Embedded Workbench for ARM 10

W pakiecie firmy IAR mo� liwe s�  dwa podej� cia do u� ywania interfejsu JTAG-lock-pick Tiny 2  – 
mo� na korzysta�  z OpenOCD (patrz rozdzia
 4.1) lub z wtyczki CooCox CoIARPlugin.

4.4.1.  OpenOCD
Pierwszym krokiem jest oczywi� cie uruchomienie w tle OpenOCD (przez wiersz polece�  systemu 
operacyjnego) z parametrami odpowiednimi dla danego uk
adu docelowego, korzystaj� c z opisu w 
rozdziale dotycz� cym OpenOCD (patrz rozdzia
 4.1).

Nast� pnie w pakiecie IAR Embedded Workbench for ARM w opcjach projektu (Project > Options) 
nale� y wybra�  z bocznego menu pozycj�  Debugger. W zak
adce Setup z listy Driver nale� y wybra�  
pozycj�  GDB Server, a w zak
adce  Download zaznaczy�  opcj�  Use flash loader(s). Nast� pnie z 
bocznego menu nale� y wybra�  pozycj�  GDB Server i w zak
adce GDB Server w pole TCP/IP ad-
dress of hostname [.port] wpisa�  localhost.

4.4.2.  CooCox CoIARPlugin 11

Po instalacji wtyczki w opcjach projektu (Project > Options) nale� y wybra�  z bocznego menu po-
zycj�  Debugger. W zak
adce Setup z listy Driver nale� y wybra�  pozycj�  RDI, a w zak
adce Down-
load zaznaczy�  opcj�  Use flash loader(s). Nast� pnie z bocznego menu nale� y wybra�  pozycj�  RDI i 

9 http://www.coocox.org/CooCox_CoIDE.htm   
10 http://www.iar.com/en/Products/IAR-Embedded-Workbench/ARM/  
11 http://www.coocox.org/CoLinkGuide/CoIARPlugin.html   
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w pole Manufacturer RDI driver wprowadzi�  � cie� k�  do pliku CoRDI.dll znajduj� cego si�  w folde-
rze   instalacyjnym  wtyczki  CooCox  CoIARPlugin (zwykle  b� dzie  to  c:\Program 
Files\CooCox\CoIARPlugin\CoRDI.dll, w systemie  64-bitowym u� yty b� dzie zwykle katalog Pro-
gram Files (x86)) oraz zaznaczy�  opcj�  Allow hardware reset. Po zamkni� ciu opcji projektu przyci-
skiem OK w oknie aplikacji pojawi si�  nowe menu – RDI. Nale� y wybra�  jedyn�  aktywn�  w tym 
menu opcj�  – Configure – i w nowo otwartym oknie wybra�  z bocznej listy uk
ad docelowy, a z li-
sty Adapter w groupboxie Adapter Config wybra�  pozycj�  KT-Link.

4.5.  Keil MDK-ARM 12

Korzystanie z JTAG-lock-pick Tiny 2  w � rodowisku Keil MDK-ARM (znanym te�  pod nazwami 
� Vision lub RealView) jest mo� liwe za pomoc�  wtyczki CooCox CoMDKPlugin13. Po zainstalowa-
niu jej, w opcjach projektu (Project > Options for Target 'nazwa_projektu', opcja dost� pna tylko po 
zaznaczeniu projektu w oknie Projects) w zak
adce Utilities nale� y z listy wyboru pod Use Target 
Driver for Flash Programming wybra�  pozycj�  CooCox Debugger, zaznaczy�  opcj�  Update Target  
before Debugging, a nast� pnie nacisn��  przycisk Settings. W nowo otwartym oknie nale� y przej��  
do zak
adki Debug i ze znajduj� cej si�  w groupboxie USB Adapter listy wyboru Adapter wybra�  po-
zycj�  KT-Link. Po naci� ni� ciu przycisku OK i powrocie do opcji projektu nale� y przej��  do zak
adki 
Debug i wybra�  znajduj� c�  si�  po prawej stronie opcj�  Use, a z listy wyboru obok wybra�  ponow-
nie pozycj�  CooCox Debugger – nie ma potrzeby ponownego ustawiania opcji przyciskiem  Set-
tings, poniewa�  s�  one wspó
dzielone (zawsze takie same dla zak
adki  Utilities i  Debug). Poni� ej 
nale� y jeszcze zaznaczy�  opcj�  Load Application at Startup oraz Run to main(). Ca
�  konfiguracj�  
nale� y zatwierdzi�  przyciskiem OK.

4.6.  Rowley CrossWorks for ARM 14

Aby móc u� ywa�  interfejsu JTAG-lock-pick Tiny 2  w � rodowisku CrossWorks nale� y zaimporto-
wa�  konfiguracj�  interfejsu z pliku targets.xml znajduj� cego si�  w folderze Rowley CrossWorks for  
ARM/ na do
� czonej do zestawu p
ycie DVD. Aby tego dokona�  nale� y w dowolnym miejscu ramki 
Targets klikn��  prawym przyciskiem myszy i wybra�  opcj�  Import Target Definitions From XML, a 
nast� pnie wskaza�  plik targets.xml. Po prawid
owym dodaniu konfiguracji na li� cie powinna poja-
wi�  si�  pozycja DISTORTEC JTAG-lock-pick Tiny 2.

Dodatkowe opcje konfiguracyjne (interfejs  JTAG/SWD, dzielnik zegara, …) dost� pne s�  w ramce 
Properties Window po zaznaczeniu interfejsu DISTORTEC JTAG-lock-pick Tiny 2 na li� cie w ramce 
Targets.

Prawid
owe po
� czenie z uk
adem sygnalizowane jest na pasku statusu aplikacji oraz wy� wietle-
niem numeru seryjnego interfejsu oknie  Properties Window dla wybranego interfejsu – sytuacja 
taka przedstawiona jest na rysunku 10.

12 http://www.keil.com/arm/mdk.asp  
13 http://www.coocox.org/CoLinkGuide/CoMDKPlugin.html  
14 http://www.rowley.co.uk/arm/index.htm  
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Rys. 10: Prawid
owe po
� czenie z uk
adem w � rodowisku Rowley CrossWorks for ARM
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5.  � ród
a dodatkowych informacji
Dodatkowe informacje i pomoc dotycz� c�  JTAGa, oprogramowania,  debuggowania i procesorów 
ARM mo� na znale��  w wielu miejscach w internecie:

� strona firmy DISTORTEC ( http://www.distortec.pl/ ),
� strona Freddiego Chopina ( http://www.freddiechopin.info/ ),
� forum Elektrody ( http://www.elektroda.pl/rtvforum/ ),
� forum SparkFun ( http://forum.sparkfun.com/viewforum.php?f=18 ),
� strona OpenOCD ( http://openocd.sourceforge.net/ ),
� strona pakietu Yagarto ( http://www.yagarto.de/ ),
� strona  pakietu  WinARM (informacje  cz� sto  nieaktualne!)  (  http://www.siwawi.arubi.uni-

kl.de/avr_projects/arm_projects/ ),
� google ( http://www.google.pl/ ).
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6.  Troubleshooting
Problem: Po uruchomieniu OpenOCD pojawia si�  komunikat:

OpenOCD Error: unable to open ftdi device

Geneza: OpenOCD do komunikacji z uk
adem FTDI FT232H mo� e wykorzystywa�  trzy 
ró� ne sterowniki – WinUSB, libusb-win32 lub ftd2xx. Wybór sterownika 
dokonywany jest ju�  na etapie kompilacji OpenOCD. Komunikat taki wskazywa�  
mo� e na kilka problemów:

1. JTAG nie jest prawid
owo pod
� czony do komputera,
2. JTAG jest „zablokowany” przez inny program lub inn�  sesj�  OpenOCD,
3. Zainstalowane zosta
y niew
a� ciwe sterowniki do JTAGa,
4. Wybrano plik konfiguracyjny niedopasowany do zainstalowanych 

sterowników.

Rozwi� zanie: Ad 1. Skontrolowa�  po
� czenie JTAG <=> PC.
Ad 2. Zamkn��  pozosta
e sesje OpenOCD lub inne programy po
� czone z JTAGiem.
Ad 3. Odinstalowa�  niew
a� ciwy i zainstalowa�  w
a� ciwy sterownik (patrz rozdzia
 
3.4).
Ad 4. Wybra�  prawid
owy plik konfiguracyjny interfejsu (patrz rozdzia
 4.1).

Problem: Próba programowania / debuggowania uk
adu w pakiecie CooCox CoIDE ko� czy 
si�  b
� dem o tre� ci:

Target Chip not found

Geneza: Pakiet CooCox CoIDE w wersji 1.4.0 nie wspó
pracuje prawid
owo z JTAGami 
opartymi o uk
ad FTDI FTx232.

Rozwi� zanie: Nale� y u� y�  wcze� niejszej (1.3.0) lub nowszej (1.5.0) wersji oprogramowania.

Problem: Po uruchomieniu debuggowania w � rodowisku CrossWorks program na d
ugi czas 
przestaje odpowiada�  lub zg
asza ró� ne b
� dy.

Geneza: Cho�  w � rodowisku tym mo� na korzysta�  ze sterowników libusb-win32 (w opcjach 
interfejsu opisanych jako LibUSB), to niestety z aktualn�  w chwili tworzenia tego 
dokumentu wersj�  programu (2.2.0) takie po
� czenie nie dzia
a poprawnie z 
uk
adem FT232H.

Rozwi� zanie: Zainstalowa�  sterownik ftd2xx (patrz rozdzia
 3.4) i skonfigurowa�  ten sterownik w 
opcjach interfejsu (Interface > Device Driver > FTDI).
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7.  Appendix
� schemat uk
adu (wersja 2.0.0-120820), str 20
� schemat i konfiguracja logiki CPLD (wersja 2.0.0-120820), str 22
� lista elementów (bill of materials) (wersja 2.0.0-120820), str 25
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7.1.  Schemat uk
adu (wersja 2.0.0-120820)
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7.2.  Schemat i konfiguracja logiki CPLD (wersja 2. 0.0-120820)
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7.3.  Lista elementów (bill of materials) (wersja 2 .0.0-120820)
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